Copyright

Copyright © 1985-2007, Cast & Crew Entertainment Services, LLC. All rights reserved.

The software described in this document is furnished under a license agreement. The software may be used or copied only in accordance with the terms of those agreements.

Trademarks

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any language or computer language, in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, for any purpose other than the licensee's personal use without the prior written permission of Cast & Crew Entertainment Services, LLC.

Cast & Crew, PSL3, PSL Online, PSL One, PSL, and the Cast & Crew insignia are registered trademarks and/or registered service marks of Cast & Crew Entertainment Services, LLC.

Other brands and their products are trademarks or registered trademarks of their respective holders. Other unregistered words, designs, logos, etc., may appear in Cast & Crew's materials and are considered proprietary to Cast & Crew Entertainment Services, LLC.

Software Versions

The material in this manual reflects the following PSL3 operational environment:

- Microsoft Window XP Professional 2002, Service Pack 2
- Java SE Runtime Environment 5
- PSL3, version 1.1
- Internet Explorer 7.0

Other software versions may appear or act differently than described in this manual.
### Customer Support

<table>
<thead>
<tr>
<th>Information</th>
<th>Contact Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone Number:</td>
<td>818-848-0999</td>
</tr>
<tr>
<td>Fax Number:</td>
<td>818-848-4780</td>
</tr>
<tr>
<td>Email address:</td>
<td><a href="mailto:support@castandcrew.com">support@castandcrew.com</a></td>
</tr>
</tbody>
</table>

### Burbank: Corporate Headquarters

- **Address:** 2300 Empire Avenue, 5th Floor, Burbank, CA 91504
- **Website:** [www.castandcrew.com](http://www.castandcrew.com)
- **Telephone Number:** 818-848-6022
- **Payroll Fax Number:** 818-848-9484

### New York Office

- **Address:** 450 Seventh Avenue, Suite 900, New York, NY 10123
- **Telephone Number:** 212-594-5686
- **Fax Number:** 212-594-5762

### Toronto Office

- **Address:** 555 Richmond Street West, Suite 1011, PO Box 305, Toronto, ON M5V 3B1
- **Telephone Number:** 416-406-2768
- **Fax Number:** 416-406-2722

### Vancouver Office

- **Address:** 4259 Canada Way, Suite 250, Burnaby, BC V5G 1H1
- **Telephone Number:** 604-437-6363
- **Fax Number:** 604-437-6362
This page intentionally left blank.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>1</td>
</tr>
<tr>
<td>Audience</td>
<td>1</td>
</tr>
<tr>
<td>Organization</td>
<td>1</td>
</tr>
<tr>
<td>Obtaining documentation</td>
<td>2</td>
</tr>
<tr>
<td>Obtaining technical assistance</td>
<td>2</td>
</tr>
<tr>
<td>Conventions</td>
<td>3</td>
</tr>
<tr>
<td>Accessing PSL</td>
<td>5</td>
</tr>
<tr>
<td>Opening the PSL3 web page</td>
<td>5</td>
</tr>
<tr>
<td>Logging in</td>
<td>6</td>
</tr>
<tr>
<td>Selecting a database</td>
<td>6</td>
</tr>
<tr>
<td>Working with screens and programs</td>
<td>7</td>
</tr>
<tr>
<td>Understanding the home screen</td>
<td>7</td>
</tr>
<tr>
<td>Title bar</td>
<td>8</td>
</tr>
<tr>
<td>Identification area</td>
<td>8</td>
</tr>
<tr>
<td>Program tree</td>
<td>9</td>
</tr>
<tr>
<td>Program menu</td>
<td>9</td>
</tr>
<tr>
<td>Program tabs</td>
<td>9</td>
</tr>
<tr>
<td>Opening programs from the home screen</td>
<td>9</td>
</tr>
<tr>
<td>Typing the program number</td>
<td>10</td>
</tr>
<tr>
<td>Clicking a program tab</td>
<td>10</td>
</tr>
<tr>
<td>Selecting from the program tree or menu</td>
<td>11</td>
</tr>
<tr>
<td>Opening two instances of the same program</td>
<td>11</td>
</tr>
<tr>
<td>Understanding programs and command screens</td>
<td>12</td>
</tr>
<tr>
<td>Setup-entry screens</td>
<td>13</td>
</tr>
<tr>
<td>Creating an Entry</td>
<td>14</td>
</tr>
<tr>
<td>Program Menu Bar</td>
<td>14</td>
</tr>
<tr>
<td>Entry Toolbar</td>
<td>15</td>
</tr>
<tr>
<td>Transaction-entry screens</td>
<td>17</td>
</tr>
<tr>
<td>Reporting screens</td>
<td>17</td>
</tr>
<tr>
<td>Posting screens</td>
<td>20</td>
</tr>
<tr>
<td>Command screen</td>
<td>21</td>
</tr>
</tbody>
</table>
Opening programs from a program screen .......................................................... 22
  Program menu .................................................................................................. 22
  Favorites ........................................................................................................ 22
  Opening a program from within another program (zooming) ......................... 23
Closing (exiting) a program ............................................................................. 24
Understanding mouse and keyboard shortcuts ............................................. 25

Using basic functions and features ............................................................... 25
Understanding data entry fields .................................................................. 25
  Recognizing field types ................................................................................ 26
  Navigating fields ......................................................................................... 27
  Using shortcuts for data entry and selection .............................................. 27
Working with entries and transactions ......................................................... 30
  Creating a new entry ................................................................................... 30
  Saving a new entry ..................................................................................... 31
  Canceling new entries or other changes .................................................. 32
  Retrieving a saved entry ........................................................................... 33
  Retrieving entries that share a field value .............................................. 35
  Changing an entry ..................................................................................... 36
  Deleting an entry ....................................................................................... 36
  Deleting a distribution line ........................................................................ 37
Posting transactions ..................................................................................... 37
  Generate an edit list (check transactions before posting) ......................... 38
  Generate a posting register (post transactions) ........................................ 39
Printing A/P checks ....................................................................................... 40
  Check types ................................................................................................. 40
  Check printing ............................................................................................ 42
Reporting activities and status .................................................................... 45
  Entering search criteria ............................................................................. 45
  Generating report output .......................................................................... 46
Getting help with PSL3 .................................................................................. 46
  Tooltips ....................................................................................................... 47
  Status bar .................................................................................................... 47

Acronyms, initializations, and glossary ......................................................... 49
Acronyms and initializations............................................................................................................ 49
Glossary........................................................................................................................................... 49

Icons and shortcuts .......................................................................................................................... 53
  Pressing function keys.................................................................................................................. 54
  Pressing named keys and key combinations .............................................................................. 55
  Right-clicking the mouse............................................................................................................. 56
  Clicking toolbar icons .................................................................................................................. 57

Index................................................................................................................................................ 59
Preface

This document is Document release of October 2007 of the getting started manual for PSL3 Software version 1, the latest version of our popular PSL production accounting software for the entertainment industry.

PSL3 offers users an internet-based solution to their production accounting software needs. This efficient, secure, and easy-to-use production-accounting software features:

- Production-cost capability
- Multiple-company capability
- Special episodic-television formats
- Multiple-production capabilities
- Payroll interface
- Onsite payroll-check printing
- Multi-user, worldwide capabilities
- Extensive, secure web access
- Multitasking capability
- Optional database hosting
- Customizable reports
- Report previewing
- Twenty-four-hour support, seven days a week (24/7)

Audience

This manual is for anyone using PSL3 to manage production payroll and costs. It introduces new users to the fundamentals of PSL3, as well as to using the help system and other manuals:

- How to access the program
- How to navigate (move around) the program
- How to use general program functions and features

This document assumes that you have online access to PSL3, as described in documentation included with the initial delivery of the program.

We assume that you are familiar with the Windows platform, Internet Explorer web browser, and production accounting.

Organization

This manual documents the information you receive during your free training. It is the first user manual a new PSL user should read.

- Chapter 1 explains how to open the PSL3 web page, log in, select a database (the show you are working on), and log out.
Chapter 2 describes PSL3 screen parts and how to direct the program.

Chapter 3 describes how to use fields, entries (records and transactions), searches, inquiries, and reporting.

The appendixes provide references: a glossary, a list of curtailed words, mouse shortcuts and keyboard shortcuts, and an index.

**Obtaining documentation**

To download a document in Adobe’s Portable Document Format (PDF), click on the support link on the program’s home screen, or contact Customer Support to have PDF files emailed to you.

Your comments are welcome! If you have any feedback on this manual, please email docsupport@castandcrew.com

**Obtaining technical assistance**

Cast & Crew offers several forms of technical assistance, including free one-on-one or group training sessions. If you need help with PSL3 or want to make an appointment for a training session, please contact Customer Support, as described on the title page.
**Conventions**

This manual employs typographic and usage conventions:

<table>
<thead>
<tr>
<th>This convention...</th>
<th>Means...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold san serif</strong></td>
<td>Title of a screen (window)</td>
</tr>
<tr>
<td>san serif</td>
<td>Word on a screen, such as a name, title or label</td>
</tr>
<tr>
<td>press</td>
<td>Press and release a keyboard key</td>
</tr>
<tr>
<td>select</td>
<td>Highlight an item by using a keyboard shortcut or mouse action</td>
</tr>
<tr>
<td>choose</td>
<td>Activate (execute) a command</td>
</tr>
<tr>
<td><code>&lt;F6&gt;</code></td>
<td>Named key on the keyboard, such as the “F6” key</td>
</tr>
<tr>
<td><code>&lt;Ctrl&gt;+C</code></td>
<td>Simultaneously press two keys, such as the control key and the “C” key</td>
</tr>
<tr>
<td><code>&lt;F1&gt;, C</code></td>
<td>Press the first key, then another key, such as the “F1” key, then the “C” key</td>
</tr>
<tr>
<td><code>&gt;</code> (right angle bracket)</td>
<td>Select items from a cascade of menus, such as Settings&gt;Text Size&gt;Large</td>
</tr>
<tr>
<td>click</td>
<td>Press and release the left button on the mouse</td>
</tr>
<tr>
<td>double-click</td>
<td>Twice in a row, rapidly press and release the left button of the mouse</td>
</tr>
<tr>
<td>right-click</td>
<td>Press and release the right button on the mouse</td>
</tr>
<tr>
<td>► <strong>Blue, arrowed text</strong></td>
<td>Begin a step-by-step instruction</td>
</tr>
<tr>
<td><img src="image" alt="white" /> Note (in margin)</td>
<td>Important or additional information that is not hazard-related</td>
</tr>
<tr>
<td><img src="image" alt="white" /> Warning (in margin)</td>
<td>Hazard-related information regarding unsafe computer practices (those that could compromise data or systems)</td>
</tr>
</tbody>
</table>
Chapter 1

Accessing PSL

PSL3 may be accessed worldwide, using a web browser such as Internet Explorer.

**Opening the PSL3 web page**

Start by opening the PSL3 web page in Internet Explorer, using the Internet address, user name and password supplied by Customer Support. You may want to add the address to your browser’s list of favorites.

► To access PSL3:

- Type this address in the address field of your internet browser and press <Enter>.

The first time you visit the PSL3 web site, a screen appears, asking whether you want shortcuts created.

If you choose to create shortcuts, the next time you want to access PSL3, you can double-click the shortcut on the desktop or click the PSL3 start-menu item.

The PSL3 home screen appears with the Login screen top.
Logging in

You must log in before you can use the program, meaning you must have a user name and password assigned to you.

► To log in to PSL3:

1. Type your user name.
2. Click in the password field (or press <Tab>). Type your password and click OK (or press <Enter>).

If your login is successful and your PSL3 is set up with a single database (that is, you are working on a single show), the home screen appears. If you’re set up with multiple databases (that is, you’re working on multiple shows), the Databases screen appears.

If your login is not successful, the Login Incorrect screen appears. Press <Enter> to restore the login screen and try again.

Selecting a database

Your PSL3 is set up with at least one database. If it’s set up with more than one (if you’re working on more than one show), you choose which database to open. If you need to switch databases, logout, login, and select the new database. To have two databases open, start another PSL3 session and select the new database.

► To select from among multiple databases:

■ On the screen, select a database and click OK (or press <Enter>). The home screen for your database displays.

Now you are ready to explore the layout of the PSL3 screens, as described in the next chapter.
Chapter 2

Working with screens and programs

PSL3 contains a set of related “program screens” that supports the range of production-accounting tasks. You open the programs from the home screen. To help with workflow, the programs are grouped several ways:

■ According to the accounting processes they support, such as accounts payable, purchase orders or payroll
■ According to the type of document used or produced, such as checks or reports
■ According to method of processing
■ According to studio, for studio-specific workflow

You can use your favorite method for navigating the program and performing accounting activities, such as entering data. You can type on the keyboard, or you can select and click with the mouse. You can modify the appearance of the program screens.

You can also set up custom versions of reports, such as trial balance and cost. (Please contact Customer Support for specifications.)

The following sections describe the PSL3 home screen, opening PSL3 programs, and program screens.

Understanding the home screen

The home screen is the first screen you see after you log in. From here, you can view top-level information, change program settings, or log out. Most often, however, you use the home screen to open or close the program screens related to the work you’re doing.

The home screen has the following areas:

■ Title bar
■ Identification area (on banner)
■ Menu bar
■ Program tree
■ Program menu
■ Program tabs
Title bar
The title bar displays the C&C insignia and the program name of the program you’re working in. The title bar also contains the buttons for minimizing, maximizing, and closing the screen.

Identification area
Below the title bar is a banner displaying the server name, show name, and the program name (of the first program opened).

Menu bar
The menu bar displays links to top-level information and settings.

Viewing the C&C home page
The first item on the menu bar is myPSL. Click myPSL and the Cast & Crew web site opens in a new browser screen.

Viewing support information
To go directly to support information on the Cast & Crew web site, click the second item on the menu bar, SUPPORT. The support page of the web site appears.

Changing the appearance of the screens and reports
The third item on the menu bar allows you to customize the PSL3 screens and reports. You can adjust on-screen items, the appearance of text and reports, and program behaviors. Click SETTINGS, and a menu with setting options appears, as shown on the left.

These options are set to the default values preferred by many users. Mousing over the Settings menu displays the submenus and settings.
Logging out
The last item on the menu bar toggles between LOGIN and LOGOUT, depending on whether you are logged in. To log out, click LOGOUT. You are logged out and the LOGOUT on the menu bar is replaced by LOGIN.

Log back in by clicking LOGIN and entering your user name and password.

Program tree
The program tree allows you to open a program from a tree-like, expandable/collapsible view of program groups. As a convenience, the same program may appear several groups.

Program menu
The program menu allows you to open a program by name, “nickname,” or descriptions, by typing or selecting it, then pressing <Enter>. An alphabetical list of choices appears when you type in the menu or press the arrow button.

You can also use the program menu to login or logout, by typing login or logout and pressing <Enter>.

Program tabs
The program tabs allow you to open, by a single mouse click, a frequently used program for the corresponding accounting process. For example, the 1 - A/P tab opens the transaction entry program for accounts payable (A/P). You can use the nine tabs as provided, or you can call support to set up any number of custom tabs.

Opening programs from the home screen
From the home screen, you open one or more programs. (You can also open programs from the program screens.) You have several ways of opening a program from here:
■ Typing the program number
■ Clicking a program tab (for frequently used programs)
■ Selecting a program from the program menu or tree

---

1 In older versions of PSL, nicknames are termed “program acronyms.”
Typing the program number

You open programs from the program tabs by typing the key combination `<Alt> + N`, where “N” is the underlined number on the tab—the “program number.”

To open a program by using the program number:

For example, open an accounts payable (A/P) program:

- Type `<Alt>` + 1. The default program in this group, A/P Transaction Entry, opens.

Clicking a program tab

You can click on the program tab to open commonly used programs. Right-clicking also works. Tab colors help you keep track of the open programs.

To open a program by using the program tabs:

For example, open a purchase order (P/O) program:

- Click the P/O tab. The default program in this group, P/O Transaction Entry, opens.

Note the P/O tab is “on top” and light blue. By definition, the program in which you are entering/editing data or running reports is in front of any other open programs (“open in the foreground”). The tab color shows whether a program is open in foreground, open in the background (open but hidden behind another program), or closed. The program name in the title bar and information area is now P/O Entry, because it identifies the program open in the foreground.

Because we haven’t closed the A/P program, it remains open but in the background (behind the P/O screen), as shown by white color of the tab.
Working with screens and programs
Opening programs from the home screen

Selecting from the program tree or menu

PSL3 also has an expandable/collapsible “tree,” as well as a type-in menu opening programs.

The program tree displays the programs in several groupings to facilitate their use in various accounting tasks. The same program may be listed by transaction-type group, by document-type group, or by the phase of the accounting cycle.

Expand or collapse the view of the group by clicking the button to the left of the group name. The button for an expanded group has a minus sign, whereas the button for a collapsed group has a plus sign.

When you expand a collapsed group, you display a list of programs in that group. Some lists contain divider lines that separate different types of programs, for example, transaction entry programs from reporting programs.

If you prefer using the keyboard to open programs (or if you are familiar with program nicknames), use the program menu. Some programs are listed more than once in the program menu, such as by full name and by nickname. For example, the entry program for A/P is listed under both its name, A/P Transaction Entry, and its nickname, “apte.”

To open the program menu, press the down arrow <↓> or start typing in the menu bar. To scroll through the list, use the scroll bar or press <Page Up>, <Page Down>, up arrow <↑>, or down arrow <↓>. Select the program, then press <Enter> or click to open it.

Opening two instances of the same program

Not only can you have many programs open concurrently, you can concurrently open many “instances” (occurrences) of the same
program. With the program already open, right-click its name in the program tree to open another instance of the program.

► To open two instances of a program:

For example, open two instances of A/P Transaction Entry:

1. Click the A/P tab. The default program in this group, A/P Transaction Entry, opens.

2. In the program tree, expand the A/P group, if not already expanded. The list of A/P programs appears.

3. Select Entry and right click. A second A/P Transaction Entry screen appears.

Now we’re ready to explore program screens.

Understanding programs and command screens

Program screens allow you to open or close programs, enter setup records, enter or post transactions, retrieve (find) entries, inquire into entries, and generate reports. As with the home screen, you can type on the keyboard or click the mouse to navigate the screens and command the programs.

Program screens have the following areas, some of them similar to those found on the home screen:

■ Title bar
■ Program menu bar
■ Toolbar
■ Working area
■ Hint bar
■ Activity bar, for screens where you work with entries

“Entry” is a generic term for a setup record or a transaction entry.
The exact layout of the program screens depends, in part, on the type of accounting procedures it supports:

- Setup (record) entry
- Transaction entry
- Reporting
- Posting
- Inquiry

Screens that support the same type of procedures have similar layouts. For example, record entry and transaction entry require similar steps and thus the setup entry and transaction entry screens are similar. The other factor affecting the layout is the type of data the screen displays, for example, bank data versus vendor data.

Once you’ve finished working in a program screen, you use a command screen to finalize your task.

Now we’ll explore the screens that new users are likely to encounter: those for data entry, reporting, posting, and commanding the program.

**Setup-entry screens**

Because the entry screens are heavily used in PSL3, let’s first explore the screens of entry programs, starting with a record-entry program, such as Vendor Entry. Use Vendor Entry to set up and save a vendor record or to retrieve a saved record for editing or deleting. When you open an entry screen, a blank screen appears, ready for data entry or record retrieval.
**Title bar**

The title bar appears at the top of program screens. It identifies the program and contains buttons for resizing or closing the screen.

**Program menu bar**

The program menu bar displays the names of the menus for working with program screens.

Click on the name to open the menu. If there is a keyboard shortcut for the menu item, it is displayed to the right of the item. Menu items with an arrow to the right open to a submenu, when you mouse over them.

Following are brief descriptions of the menus you can access from the program menu bar.
File
The File menu allows you to set up printer pages and exit the program.

Edit
The Edit menu allows you to edit and find (retrieve all or some) transaction entries.

Programs
The Programs menu (shown at the beginning of this section) provides another option for opening programs. Although it uses a menu format instead of a tree format, the programs are organized as they are in the program tree.

Options
The Options menu provides a mouse-based way of accessing keyboard shortcuts for working with fields, working with entries, and for opening Help. You can also use it to exit (close) a program.

Favorites
The Favorites menu provides quick access to programs you’ve added to your PSL3 favorites.

Help
The Help menu provides several types of help, as well as “about the program” information.

Entry toolbar
The entry-program toolbar displays at the top of all entry program screens. Click on a toolbar icon to activate the associated action. If an icon is colored gray instead of blue, the action is not available.
Working area

The working area of an entry screen displays the fields that contain the data you type or select. Group boxes such as Currency Information or Rate Information visually cluster related entries.

Hint bar and activity bar

Beneath the working area is a “hint bar.” This bar names the selected field and describes valid data for the field, for those fields with built-in choices.

The bottom area of the screen is the “activity bar.” The content of the activity bar depends on whether you’ve started working on entries.

When you first open an entry screen, it is blank, and the activity bar prompts you to search for entries or add data. Once you add a new entry or retrieve saved entries, the activity bar shows activities since the last save.

On the left side of the bar is an activity indicator, showing which of the available entries you are displaying. It shows the sequence number of the displayed entry and the total number of entries available. The right side of the activity bar displays the number of...
entries you’ve added, modified and deleted since your last save. On the far right of the activity bar is a handle for resizing the screen. To resize the window, select the handle and drag it.

**Transaction-entry screens**

Transaction entry screens are similar to record entry screens, such as the Vendor Entry screen shown on page 14. However, the working area of a transaction entry screen divides into two distinct sections:

- **Header section**
- **Distribution section**

**Header section**

The header section contains the reference number and the reference description (hence its other name “reference section”). The reference number uniquely identifies the transaction, and the reference description describes the overall transaction. You set up this section before you start adding distributions in the distribution section. You also use the header section to retrieve saved transactions.

**Distribution section**

The distribution section is unique to transaction entry screens. It shows how the amount in the transaction header is distributed among account numbers, series, locations, and sets (hence the name distribution).

**Reporting screens**

Reporting screens are used to specify report options and generate reports, either hard copy or online. You can open reporting
programs from the home screen or from another program. Because of their significance, cost reports, bible runs, and trial-balance reports have program tabs on the home screen.

Although report screens are similar to record entry screens, they are typically used after entries are saved to the database. The following sections describe key parts of the reporting screen.

**Reporting toolbar**

The reporting toolbar contains a subset of the icons that appear on the entry toolbar, plus icons specific to reporting.

**Working area**

The body of the reporting screen features fields for selecting the transactions to appear in the report, the type of report, and the
report setup. The working area also contains fields for ordering and formatting the report.

Right-clicking inside a field displays a pick list, to help you select the entries you want to appear in your report. Right-clicking outside a field displays a shortcut menu of reporting options. These options are also available from the Options menu on the program menu bar.

**Button panel**

On the right of the working area is the button panel, with report output and program-exit buttons. After you select the entries to appear in the report, you click an output button to generate the report output. You can send the report to the printer, display it on the screen, or open it in a spreadsheet program.

You can change the program focus to the button panel (to the first button, Print) through the Options menu. Right-clicking outside a field, or by pressing `<Alt>+X`, where `X` is an underlined letter (`<Alt>+V` to preview a report, for example). You can also use the arrow down key to scroll through each button.

**Activity bar**

Many report screens also have an activity bar. Although the activity area is blank, the bar is still useful for screen resizing.
**Posting screens**

Posting screens are similar to reporting screens. You post transactions by generating a posting-register report. As with other reports, you can post all available transactions or use selection criteria to post only certain transactions, and you can generate report output to the screen (print preview), to a printer, or to a spreadsheet program.

Once you’ve specified posting criteria (or left the criterion fields blank, to post all available transactions), you have the option of checking the data and report setup by generating an edit list report. Once you verify the edit list report, you can post the selected entries by changing the report type to Posting Register and by generating the report.

**Print preview screen**

Among other output options, reports may be generated as online previews of the printed reports. The preview shows what the report would look like if it were printed. The preview is a PDF file that displays in Adobe Acrobat or in the Preview screen.

To view a report onscreen, click the Preview button or select Report from the Command screen. Once you preview your report, you can go ahead and print it or close the screen.

When you click the Preview button, PSL3 defaults to opening a PDF file of the report in Adobe Acrobat.
Previewing menu bar
Although the preview menu bar lists the same menus as other screens, the menus are tailored to previewing. The View menu allows you to shrink or expand the previewed report page. The Options and Favorites menus are disabled and Find does not function.

Previewing toolbar
The preview toolbar contains a subset of the icons that appear on the entry toolbar, plus icons specific to previewing and printing.

Command screen
Command screens provide options for completing a task on a program screen. Typically, you use the command screen to finalize the task, such as data entry or reporting. The layout of the command screen varies, depending on the type of task (and thus type of program screen). Each command option takes the form of a shortcut letter, parenthesis, and command name, with the shortcut letter capitalized. For example, an option that appears on all command screens is `X) eXit to menu`.

You can use either the mouse or the keyboard with a command screen.

► To use a command screen:

1. From a program screen, press `<F1>`. A command screen appears.
2. Choose the command, using the mouse or keyboard.
   2a. To choose the command by using the mouse, select the option, then click OK. The command executes (performs its action). (Some commands execute as soon as you select them, if there are no changes or if changes are already saved.)
   2b. To choose the command by using the keyboard, either:
      □. Press the arrow keys to select the option, then press `<Enter>`; or
Type the shortcut letter and press <Enter> (some commands execute as soon as you type the letter, if all changes are already saved); or

Press <Alt>+X, where X is an underlined letter. (Only a few screens offer this shortcut.)

As you can see, the command screens offer many options for choosing commands. To keep descriptions simple, this manual describes only the keyboard option. For example, cancelling adding a new entry is described as <F1>, C, <Enter>, but you can use whatever option suits you.

What if you don’t need the command screen after you’ve opened it? You have several options for quitting the command screen without invoking a command:

- Press <Esc> (the Escape key)
- Press <Ctrl>+U
- Click the Cancel button on the command screen

Opening programs from a program screen

Program screens provide several options for opening other programs, in addition to those found on the home screen.

Program menu

You can open a program by selecting it from the Programs menu.

Favorites

Instead of mousing through the program menus, you can add a program to the PSL3 Favorites menu and open it from there. As with your web browser, you can create subfolders and reorganize, rename, or delete your favorites as needed. Subfolders created in Favorites appear as submenus in the Favorites menu.

► To add a program to your favorites:

1. Open the program you want to add (for example, the Bank Entry program).
2. From the program menu bar, select Favorites > Add Favorites. The Add Favorite screen appears.
3. To add the program as shown in the Name field directly to the Favorites menu, click OK or press <Enter>.

### Opening a program from within another program (zooming)

You open a program from within another program by using Zoom. Zooming is especially helpful when you want to add a new entry or search for entries in another program while remaining in the current program.

The type of field your cursor is in determines whether zoom is available. If the Zoom icon is available on the toolbar (colored blue, not gray), you can zoom from the current field to the other program, either by clicking the Zoom icon or by pressing <F5>. Choose Fetch (by clicking the Fetch icon on the toolbar, or by pressing <F1>, <F>, <Enter>) to save the entry in the other program and “fetch” (retrieve) it to the current program.

For example, you enter a new bank code in Bank Entry. You want the bank code to use the Euro currency, but the currency is not set up. With your cursor in the Currency field, in the Currency/Date Information box, click the Zoom icon to jump to the Currency Code Entry program. Now, enter the new currency code and then click the Fetch icon to fetch it back. Therefore, instead of having to exit Bank Entry, you can zoom to Currency Code Entry, enter the new currency code, fetch it back, and continue making more entries in Bank Entry.
Closing (exiting) a program

Closing (exiting) saves the changes you’ve made to your database and closes the program, unless you use the command screen. In that case, you’re prompted to disposition (address by saving or canceling) your changes.

You can use any one of these methods:

- Click on the Exit icon on the toolbar. The Select an Action: screen appears.
  - If you have unsaved changes and want to commit them to the database, press A (the shortcut letter for A) ACCEPT changes and exit to menu, <Enter>; or
  - If you want to discard all changes since the last save, press C (the shortcut letter for C) CANCEL changes and exit to menu, <Enter>.

The program closes.

- Select File>Exit to save any changes and close the program, or
- Press <F1>. The command screen (titled Command? or Select an action:) appears, depending on whether you have unsaved changes.
  - If you have no unsaved changes, press X (the shortcut letter for X) eXit to menu, <Enter>.
  - If you have unsaved changes and want to commit them to the database, press A (the shortcut letter for A) ACCEPT changes and exit to menu, <Enter>; or
  - If you want to discard all changes since the last save, press C (the shortcut letter for C) CANCEL changes and exit to menu, <Enter>.

To avoid data mishaps, use File>Force Exit only when the program is not responding.
Understanding mouse shortcuts and keyboard shortcuts

Once you are familiar with PSL3 screens, you can use mouse shortcuts and keyboard shortcuts to quickly navigate the program. Other shortcuts allow you to quickly enter data or inquire on saved entries.

In this chapter, we’ve described some shortcuts for opening and closing programs. More shortcuts are described in the next chapter, as we introduce the functions and features they support. The appendix “Icons and shortcuts” provides summary tables of shortcuts.

Chapter 3

Using basic functions and features

In PSL3, you enter data in fields, which are saved as entries (records or transactions). As you set up your accounting framework and begin tracking transactions, you use find functions and inquiry functions to retrieve data and generate reports. Keyboard options and mouse options provide shortcuts for working with fields, entries, reports and for getting help.

Understanding data entry fields

PSL3 provides both text-entry and checkbox fields for entering data. Field boxes are colored to let you know whether you can enter data into a field. You have keyboard options and mouse options for navigating and working with fields.
Recognizing field types

The background color of the field box tells you whether the field is selected, and whether the field is required, optional, or provided by PSL3, for information only:

- Dark blue: selected field
- White: (unselected) required field
- Light blue: (unselected) optional field
- Gray: inactive field (that can’t be selected), provided by PSL3 for context, to help you verify the data you’ve entered. For example, entering an existing vendor’s identification number in A/P Transaction Entry displays the vendor’s name and address in the Vendor Information box.

Required fields must have valid data entered in them before the entry can be saved. Every entry has at least one required field. In the preceding illustration, the only required field shown is the vendor identification field.

If you try to save an entry that has a blank (or otherwise invalid) required field, an error message displays and you cannot save the entry.

Checkboxes

Checkboxes have three settings in PSL3. The settings have slightly different meanings depending on whether you’re entering data or whether you’re retrieving entries or generating reports.

<table>
<thead>
<tr>
<th>Checkmark</th>
<th>Checkmark setting</th>
<th>Set during data entry</th>
<th>Set during retrieval, inquiry, or reporting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No checkmark</td>
<td>Checkmark field value is equivalent to &quot;no&quot; response to hint question</td>
<td>Include entries that have this checkmark setting, or don’t include this option</td>
</tr>
<tr>
<td>✓</td>
<td>Black checkmark</td>
<td>Checkmark field value is equivalent to &quot;yes&quot; response to hint question</td>
<td>Include entries that have this checkmark setting, or include this option</td>
</tr>
<tr>
<td>✓</td>
<td>Gray checkmark</td>
<td>Checkmark field value is empty—the hint question is unanswered</td>
<td>Ignore this field when selecting the entries to be returned</td>
</tr>
</tbody>
</table>
To cycle through checkbox settings, click the checkbox.

No checkmark
In data entry, no checkmark is equivalent to answering “no” to the question in the hint bar. In retrieving entries, inquiring into entries, and generating reports, only entries where the field is unchecked (where the condition is false) are included in the results.

Black checkmark
In data entry, a black checkmark is equivalent to answering “yes” to the question in the hint bar. In retrieving entries, inquires, and reports, only entries where the field has a black checkmark (where the condition is true) are included in the results.

Gray checkmark
In data entry, a gray checkmark means the field is empty. In retrieving entries, inquires, and reports, it means the field is not used to select the entries included in the results—entries are included regardless of whether this field is checked, unchecked or empty.

Navigating fields
You can jump from field to field by clicking the mouse in the field box, or by using your keyboard. Press <Tab>, <Enter>, or down arrow <↓> to move from one field to the next without taking your hands off the keyboard. You can change enter key behavior from Settings menu on the home page.

To jump back one field, press <Ctrl>+U, <Shift>+<Tab>, or up arrow <↑>.

To jump to the next group box (for example, from the Vendor Information to Invoice Information groups shown on page 26), use <Ctrl>+<Tab>.

Using shortcuts for data entry and selection
PSL3 helps you quickly fill in data fields by providing pick lists, list screens, right-mouse-button shortcuts, and keyboard shortcuts. You also use these shortcuts when you specify data for searches and reports.

Using pick list screens or list screens
A “pick list” is a popup list of available data for a field, such as state abbreviations or the codes you enter when you’re setting up your accounting framework (production codes, company codes, bank codes, etc.). Pick lists allow you to “look up” data for entry in the selected field, without leaving the field.
For example, a pick list is available for the Reference Number field in transaction entry screens.

Opening a pick list
You can tell if a pick list is available for a field by selecting the field (placing the cursor in it) and checking the availability of the pick list icon in the toolbar.

If the pick icon is available (colored blue, not gray), open the pick list for the selected field by clicking on the pick icon, by pressing <F2>, or by right-clicking the mouse button.

Browsing a pick list
Browse a pick list by using the mouse or keyboard:
- If you have a mouse with a scroll wheel, you can scroll through the pick list.
- Use the up or down arrow keys (<↑> <↓>) to move up or down one item at a time.
- Use <Page Up> and <Page Down> to move one screen at a time through an extensive pick list, such as Account Numbers.

Picking items
To populate a field with an item from its pick list, select the item and click OK or press <Enter>. The pick list closes and the data item appears in the field.

Some fields allow more than one item to be picked at a time ("multipicking"). To multipick, hold down <Ctrl> while selecting the desired items, then release <Ctrl> and press <Enter> or click OK. To select all the items on the pick list, click All and press <Enter> or click OK. To clear your selections, click None.

When you click OK or press <Enter>, the pick list closes and the field is populated with the data you selected.
Exiting without a selection

You have several ways of exiting a pick list without making any selection:

■ Click the Cancel button
■ Click the close window icon.
■ Press <Esc> (escape key)

Using the right mouse button

PSL3 provides right-mouse-button commands for working with fields. When the cursor is in a field and you right-click the mouse button:

■ If available, a pick list displays
■ If the field is for an amount, a calculator displays
■ If the field is for a date, this month’s calendar displays

Using the keyboard

PSL3 provides keyboard shortcuts for working with data:

■ <Ctrl>+X blanks out a field (instead of selecting the field data and pressing <Delete>)
■ <Backspace> deletes the character to the left of the cursor
Left arrow <←> moves the cursor one character left, and right arrow <→> moves the cursor one character right.

<Ctrl+W> restores the previous value in a field, if you haven’t moved the cursor to another field.

---

**Working with entries and transactions**

“Entry” is the general term for a setup record or accounting transaction that is saved in PSL3. Throughout a production, you add, change and delete entries. Entries are most easily changed when you first create them, before they are saved. Once you have saved an entry, certain fields cannot be changed.

To create a new entry, open a setup or transaction-entry program and fill in at least the required fields. You can create as many new entries as you want in a data-entry session.

To change or delete a saved entry, open a program and retrieve (find) the entry from the database, which displays the entry in the program screen. You can retrieve all the entries in your database or a subset as small as one entry. Keyboard shortcuts and mouse shortcuts allow you to quickly browse retrieved entries and change field data.

---

**Creating a new entry**

When you create a new entry, consider how you assign the unique identifiers to setup records, should your show not use a prescribed system. You assign the identifier when you fill out the code or ID field. PSL3 automatically assigns the identifiers (reference numbers) for transaction entries. You cannot change the identifier of a saved entry.

For transaction entry, the required fields in the header section must contain valid data before you can add data in the distribution section.
To create a new entry:

For example, to set up a new vendor:

1. Open the entry program (for example, the **Vendor Entry** program).
2. Click the Add icon on the toolbar, or press `<F4>`, or right-click and choose Add from the shortcut menu. A blank screen displays.
3. Fill out at least the required fields for the vendor. If the required fields do not contain valid data, you cannot save the entry or retain the data you’ve entered when you go to another entry.

At this point, you can create another entry or save the entry you just made. If the program finds any errors in the new entry, an error message appears. To avoid loss of data, fix the errors before moving on to a new blank entry.

If you need to start over while adding a new entry, click the Clear icon to clear the screen.

The order in which you create new entries is not important—you can create entries any time you have the required data available. The entries come out in order when you use them. Retrieving (finding) saved entries displays them in order by their unique identifier, and you specify the order for showing fields or entries when you make inquiries or generate reports.

**Saving a new entry**

You can save new entries as you create them, or you can save them all at once, when you’re finished with the entry program. When you save an entry, it is added to the database. You may then safely close the program, knowing the entry is stored in the database.

If you decide to cancel instead of saving, all changes since the last save will be lost.

Certain conditions must be met before you can save an entry:

- Neither new nor updated entries can be saved until all required fields are filled out.
- In transaction entry screens, certain data must balance:
  - In **A/P Transaction Entry**, the sum of the distribution lines must equal the amount of the invoice.
- In P/O Entry, the sum of the distribution lines must equal the total P/O amount.

- For journal entries (J/Es), payroll entries (P/R) and petty cash (P/C) entries, (J/E Transaction Entry, P/R Distribution Entry, P/C Entry), debits must equal credits.

You have several options for saving an entry (and any other changes since the last save). These options are available from the toolbar or from a command screen:

<table>
<thead>
<tr>
<th>Icon</th>
<th>&lt;F1&gt; command screen option</th>
<th>Saves entry?</th>
<th>Displays saved entry?</th>
<th>Closes program?</th>
</tr>
</thead>
<tbody>
<tr>
<td>U</td>
<td>U) Update</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>A</td>
<td>A) Accept</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>C</td>
<td>C) Cancel</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>X</td>
<td>X) eXit</td>
<td>Yes</td>
<td>N/A</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Use Update to save work in process, especially when you enter many entries or when you enter a transaction with many distribution lines.

To save a new entry, do one of the following:
- Click the Accept icon on the toolbar; or
  - Press A, <Enter>. The new entry is saved, the screen is cleared, and the program remains open; or
  - Press U, <Enter>. The new entry is saved and remains displayed in the program; or
  - Press X, <Enter>. The new entry is saved, the program screen is closed, and the home screen is displayed.

You can add several entries and then save, or you can save after each entry.

**Canceling new entries or other changes**

Canceling erases all the new entries and changes to entries since the last save. The updates are not applied to the database. Do one of the following to cancel:
- Click the Cancel icon on the toolbar, or
- Press <F1>, C, <Enter>.
Retrieving a saved entry

Once your database contains saved entries, you can retrieve them (display them in a program) so that they are available for reviewing, changing or deleting.

To retrieve entries, open the program you want to work in, and retrieve the entries you want to change (or retrieve all entries). The program screen displays the entries, starting with the first entry. The entries are ordered by identifier (numerically or alphabetically).

Finding entries

You retrieve entries by using Find in a transaction entry program or setup program. If you retrieve entries without first entering a search criterion, you retrieve all the entries for the program.

If you want to retrieve only entries that meet a specific criterion (search for entries that have a certain field value, for example), you enter the criterion (such as a field value), and then use Find. In transaction entries, only fields in the header section are used for entering search criteria.

You can retrieve a specific entry if you know the value of its unique identifier.

Retrieving all entries

To retrieve all entries, open a transaction entry or setup program that displays the type of entry you want to retrieve (vendor, A/P, bank, etc.). With the cursor in any field, click the Find icon on the toolbar or press <F7>. All entries are retrieved, and the first in the sequence displays in the screen.

For example, let’s say you want to change an A/P transaction but you don’t recall anything specific about it. You can retrieve all the A/P transactions and then browse through them until you recognize the one you want to change.

To retrieve all entries:

Example: Retrieve all A/P transactions.

1. Open A/P Transaction Entry. A blank transaction screen displays.
2. Place the cursor in any field in the header. Because you are not entering specific criteria, it doesn’t matter which field.
3. Click the Find icon or press <F7>. The first A/P transaction displays. The status bar shows you that it is transaction 1 of N, where N is the total number of transactions retrieved.
Retrieving entries that share a field value

To retrieve some subset of entries, you specify one or more search criteria before you choose Find. Only entries whose values match the criteria are retrieved. In transaction entries, you enter criteria only in the header section. For example, you can enter criteria in fields such as Reference Number, Date, Amount, or Currency Code.

Enter at least one search criterion in the corresponding field of an entry screen, and then click the Find icon on the toolbar or press <F7>, F, <Enter>. For example, let’s say you want to retrieve entries only for those vendors who have a W9 tax form on file.

✦ To retrieve entries that share a field value:

Example: Retrieve all vendor entries where a W9 is on file.
1. Open Vendor Entry. A blank entry screen displays.
2. Under Tax ID Information, click the checkbox for W9 on file until the checkmark is black. Only vendor entries where a W9 is on file (where the checkbox has a black checkmark) will be retrieved.
3. Click the Find icon or press <F7>. The first entry for a vendor with a W9 file displays. If no matching entries are found, a message is displayed.

Find entries by using a wildcard

You can use a wildcard to find entries that match some part of a field value, or entries where you know only part of a field value. The wildcard character is the asterisk (*). Use it to represent any number of characters, in any position relative to the value to be matched. In a search, you can use both criteria with wildcards and criteria without.

Often, the value to be matched is sandwiched between wildcards, to retrieve all entry where the field contains the matching value, regardless of whether the value is at the beginning, middle, or end of the field.

For example, let’s say you use wildcards to find all P/Os that have “rent” in the Description field, under Reference Information. Assume the search criterion *rent* returns entries with these Description field values:
- Misc. rental fees
- October auto rental
- Rental: weekly

The retrieved entries have the matching value at any position in the field. If rent* is used instead (without a wildcard preceding), the only entry returned is the one where the matching value begins the field:
- Rental: weekly
In another example, you’re entering an invoice from JGT Studio, Inc., in the A/P Transaction Entry screen. You don’t know the vendor ID for this studio, but you do have the name on the invoice, and thus you can search by a keyword in the name, in this case “studio.”

With your cursor in the ID field, under Vendor Information, zoom to the Vendor Entry screen (see page 23 for zoom details). In that screen’s Name field, type “stu*” and click the Find icon on the toolbar. Typing “stu*” with the wildcard characters before and after it tell the program to find all vendor entries whose name includes the letters “stu,” whether preceded or followed by other letters (or no letters). Entries that have the following values in the Name field would be returned:

- Studio Art and Tech
- REB Studio Rentals
- C VALLEY STUDIO
- JGT STUDIO
- Stunts R Us
- West Costume Inc

Select the entry named “JGT STUDIO” and fetch the entry back to the A/P Transaction Entry screen.

Finding one specific entry

To find one specific entry, enter the unique identifier for the entry in the corresponding field, and then choose Find.

► To find an entry with a known identifier:

Example: Find the A/P transaction with reference number 864.

1. Open A/P Transaction Entry. A blank entry screen displays.
2. In the Number field of the Reference Information box, type 864.
3. Click the Find icon or press <F7> or press <Enter>. The transaction displays. Because you specified a unique transaction (by specifying its reference number), the status bar shows you that it is transaction 1 of 1 retrieved.

Browsing retrieved entries

If you retrieve many entries, you can browse them an item or a page at a time:

- Toolbar icons display to the first, prior, next, or last entry.
- Pressing <Page Up> takes you to the prior entry; <Page Down> takes you to the next entry.
Right-clicking outside of a field displays a shortcut menu of entry options.

**Changing an entry**

To change an entry, first retrieve it, using Find, without or with search criteria to narrow down the number of entries retrieved. Make the changes, and then save the entry, as described in “Saving a new entry” on page 31.

As with new transactions, changed transaction entries cannot be saved unless the transactions balance.

Once you post a transaction entry, you cannot change it.

**Deleting an entry**

Deleting an entry is a two-step function in PSL3. First, you retrieve the entry and mark it for deletion, and then you actually delete it from the database. You can toggle between marking and unmarking an entry for deletion, and you can delete one or more entries at a time.

You cannot delete an entry once it is used in a transaction, and you cannot delete a transaction (or distribution lines) once the transaction is posted.

**Single entry**

To delete a single entry:

1. Place the cursor in any field of the screen (or header field, if it’s a transaction screen).
2. Click the Delete icon on the toolbar (or press `<F10>`). The entry is marked for deletion, indicated by the red strikethrough and the activity bar. However, the entry is not deleted from the database until you accept the change. The Delete icon and `<F10>` toggle between marking and unmarking an entry—using them on a marked entry unmarks it.
3 Click the Accept icon on the toolbar (or press <F1, A, <Enter>>) to accept the deletion. The screen clears and the entry is permanently deleted.

**Multiple entries**

Delete more than one entry at a time by browsing through the entries until you display one that you want to delete. Click the Delete icon to mark it for deletion; then continue browsing and marking entries. The activity bar indicates that entries are marked for deletion. If you mark the wrong entry, click the Delete icon again to unmark the entry. Click the Accept icon on the toolbar to delete all entries marked for deletion.

**Deleting a distribution line**

Deleting a distribution line works just like deleting an entry. With the cursor in any field in the distribution line that you want to delete, press <F10> or click the Delete icon on the toolbar. A red line appears through the line, indicating that this line is marked for deletion. The line is not actually deleted until you accept the change. Until you accept the changes, you can unmark a line for deletion by clicking the Delete icon a second time.

As with changed entries, changed distribution lines cannot be saved unless the changes result in distribution lines that balance.

**Posting transactions**

Posting is the act of permanently transferring a transaction to the general ledger. You decide when to post accounts payable, journal entries, petty cash and payroll transactions. Checks are posted automatically when they are printed. Purchase orders and variance entries are not posted.
To post transactions, you open a posting program, select the entries
to post (or do nothing to post all postable transactions), review the
transactions to be posted, make changes as needed, and post the
transactions.

To post all postable transactions, leave the search criteria fields of
the posting program blank. All transactions are retrieved. To
retrieve only certain transactions, enter search criteria, as described
in Finding entries, on page 33.

**Generate an edit list (check transactions before posting)**

To review transactions you can generate an “edit list”: a list of the
transactions you’ve selected for posting. You can print the edit list
or view it online.

If you need to make changes or corrections, make the changes in
the program in which you entered the transaction. After accepting
the changes, generate another edit list to verify the changes. When
you’re satisfied with the changes, post the transactions.

► **To review transactions to be posted:**

1. Open a posting program, such as **Post A/P Transactions** or **Post
   P/R Transactions**.

2. To post selected transactions, enter the search criteria in the
   fields of the posting program. For example, to post only those
   transactions found in a specific batch, enter the batch number.
   To post all postable transactions, leave the fields blank.

3. In the Report Type box, click **Edit List**. Selecting **Edit List** before
   you post allows you to review the transactions to be posted.

4. Select the desired report format, report sort, and description, if
   you want other than the default values.

5. Press **<F1>**. The command screen appears. At the prompt,
   choose the desired output option. The edit list is generated.
### Using basic functions and features

#### Posting transactions

<table>
<thead>
<tr>
<th>Option</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Send the output to Print preview</td>
</tr>
<tr>
<td>Print</td>
<td>Print the report: displays the Print dialog screen</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>Send the output to a spreadsheet</td>
</tr>
<tr>
<td>Clear</td>
<td>Clear the screen of selection criteria</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the posting program and return to the PSL3 home screen</td>
</tr>
</tbody>
</table>

If you selected Spreadsheet in the Command screen, PSL3 will open your spreadsheet program (such as Excel) and generate the report in a new spreadsheet.

6. If you find you need to change a transaction, use the program in which you entered it. For example, use the J/E Transaction Entry program to change unposted entries shown in a journal-entry edit list.

### Generate a posting register (post transactions)

When you are certain that the transactions to be posted are correct, generate a posting register, and confirm posting.

- **To post transactions:**
  1. In the posting program, enter the search criteria in the fields. To post all postable transactions, leave the fields blank.
  2. In the Report Type box, click Posting Register.
  3. Select the desired report format, report sort, and description, if you want other than the default values.
  4. Press `<F1>`. The command screen appears. At the prompt, choose the desired output option (preview, print or spreadsheet). The posting register is generated.
  5. A message displays, asking if the register printed correctly.
  5a. If the register is correct, click Yes on the message screen, and the transactions posted screen appears.
5b If there is a problem with the posting register or you don’t want to post the items, click No. A message appears, asking if you want to reprint the posting register.

- To cancel the posting process, click No. The posting program closes, and the Posting Not Done screen appears.
- To print the posting register again and continue posting from step 5, click Yes.

**Printing A/P checks**

After you post A/P invoices, you can print computer checks to pay these invoices. You can also print a check upon demand or record manual (handwritten) checks.

After you print checks, you can export and report on positive pay, print summary or detailed check registers, void checks or reconcile bank statements.

**Check types**

PSL3 handles three types of checks:
- Computer checks
- Checks on demand
- Manual checks

**Computer checks**

Computer checks are runs of checks printed by a computer. To view the open items that will print on the next check run, use the Pre-Check Printing Report program.
You can print checks for all the open items or select which items should have checks printed. Use the Print Checks program (listed as Computer Checks in the program tree).

**Checks on demand**

Checks on demand are a single, quick-turnaround computer check produced to immediately pay an invoice. You can pay new A/P transactions in this fashion.

To process a new invoice for a “check on demand,” open the Check Entry program by typing `ckent` (the program’s nickname) in the program menu bar.

Enter the check and A/P data needed to create an A/P invoice. Check the alignment of the check stock by pressing `F1`, T or by clicking the Alignment button and following the prompts.

Once the stock alignment is verified, print the check by pressing `F1`, P or by clicking the Print button and following the prompts. When you verify that the check has printed correctly, the program saves the associated A/P transaction and codes the amount of the check to the suspense account. When you are ready to post the A/P transaction, change the Account code to the actual account.

**Manual checks**

A manual check is a check written by hand, not printed by computer. Such checks may be used to pay a saved, open transaction, whether posted or unposted. To record open A/P or petty-cash items paid with manual checks, use the Change Open Items Into Manual Checks program (listed as Manual Checks/Open
Items in the program tree). Another option is to enter the check number in the A/P check number field before posting.

**Check printing**

The general approach to printing computer checks is to:

1. Open the **Print Checks** program, set up the check information to match the check stock, and select the checks to be printed.

2. Print an alignment form to verify the stock is aligned correctly.

3. Print the checks and verify whether the check printed correctly.
   - Incorrectly printed checks are marked as alignment voids and reprinted.
   - Correctly printed checks are posted.

4. Exit the check-printing program and print the check register.

**Enter check information**

In the **Print Checks** program, accept or change the defaults for Company, Bank, Currency, Starting Check # and Check Date. Verify that the check number matches the number on the check stock.
Allow ZERO Checks to Print defaults to not printing zero-amount checks. If this checkbox is checked, zero-amount checks print, and the transactions associated with the checks are marked "paid" and are no longer open.

**Selecting a check for print**

To print checks for specific transactions, enter selection criteria in the Open Item Selection group. You must specify the bank code. Leave fields blank to select all checks ready for printing.

Entering a date in the Select A/P by Due Date field selects only those open A/P transactions whose due date is on or before the date entered. Open A/P transactions with a blank Due Date field are also selected. (They are treated as if their due date is the selected date.)

**Aligning the printer**

Next, print an alignment form to verify that the check will print properly on the check stock. Press `<F1>`, `<P>` or click the Alignment button. Prompts allow you to change the print stock and printer settings. PSL3 prints “xxxxxxx” on the check stock so that you can verify field alignments before you print actual checks. PSL3 automatically voids the check numbers used on the alignment form.

If you can’t get the stock to align, contact Customer Support.

**Printing (and posting) a check**

With alignment verified, print checks by pressing `<F1>`, `<P>` or by clicking the Print button. A warning prompts you to change printer stock. Press `<Alt>+O` or click OK to continue. The Items Selected screen appears, summarizing the number of check forms needed. Press `<Alt>+O` or click OK and an Information screen prompts you to verify the print run. Press `<Alt>+O` or click OK and the Print screen appears. Click Print, and the checks print.

The printed check screen appears, prompting you to enter the last correctly printed check number. The field defaults to the last check number printed. If a check misprints, you must reprint all checks after the first misprint, even if a subsequent check printed correctly.

Accept the default or enter the number of the last correct check, and press `<Alt>+O`. If no checks printed correctly, blank out the field and press `<Alt>+O`. The first misprinted check and all subsequent checks are reprinted. The misprinted checks are marked as alignment voids and must be reprinted with a new check number.
When you enter the number of the last correctly printed check, the correct checks are posted. The A/P offset account number is debited by the same amount it was credited for when you posted the A/P transaction. The cash in bank account number is credited for the check amount.

You are now ready to print another run of checks or exit the check-printing program. Let’s exit the program and print the check register.

**Printing the check register**

When you exit the check-printing program, you are prompted to print a summary check register. At the prompt, press `<Alt>+O`. The register prints as a PDF file.

```
Sample summary check register.
```

Another prompt appears, querying whether the register printed properly. If the register printed properly, press `<Alt>+Y` or press `<Enter>`. The check-printing program closes and the home screen displays.

If the register did not print properly, press `<Alt>+N`. The Print dialog screen re-displays. Reprint the register. Eventually you must answer “yes” to whether the register printed correctly.
Other post-printing activities

In addition to printing check registers, PSL3 offers programs to export and report on positive pay, void checks, print check registers or reconcile bank statements. You can print a detailed check register, in addition to the summary one produced in the check-printing process. The detailed check register shows for each check the account distributions (account numbers, descriptions and amounts), followed by the total payment amount of the checks in the register. These programs are listed in the program tree.

Reporting activities and status

Financial reports from PSL3 not only document accounting activities and status, they also may answer inquiries about the show’s accounting or payroll. The program tree and program menu list the standard reports available.

To create a report, open a reporting screen, specify options for the report, and then generate it. You can specify the report’s content, organization and output (online Excel file or hard copy, for example). The report’s content may include all or some of the report fields on the program screen, for all or some of the entries in the database.

Entering search criteria

Enter search criteria in one or more fields to restrict the report output to specific entries. Or leave all non-required fields blank to generate a report that includes all entries. For example, in Vendor Listing, enter CA in the State field to select only those vendors in California.

In a second example, let’s say you want to see all the invoices charged against your car allowances, account number 127-47-000 for insurance claim “D,” for the default location during January. You can retrieve a report on only these invoices by entering search criteria in a general-ledger (G/L) reporting program.

Because you want to look up G/L information by account, open the G/L Account Inquiry Report program. Then enter the following search criteria:

- Account Number 127-47-000
- Location Code 00
- Insurance Code D
- Start Date 01/01/06
- End Date 01/31/06

You can clear entered search criteria by pressing <F1>, C or by using the clear icon. The program fields are blanked out.
Generating report output

When you’re ready to generate your report, PSL3 gives you a choice of three output options:

- **Print**: send the report output to the printer. Selecting this option displays the Print dialog screen.
- **Preview (<F1>, R)**: generate the report as a PDF file and display it onscreen. You can save the PDF file to retain an online version of the report.
- **Spreadsheet**: send the report output to a spreadsheet program, such as Excel, and open the output as a new spreadsheet.

You can use keyboard shortcuts, the button panel, toolbar icons or command screen to generate the report. If you don’t want to generate the report, cancel or close the program.

**Getting help with PSL3**

The PSL3 program has user assistance built into it. The program features tooltips, a status bar and field detail.
If you need additional help while you are using PSL3, please contact Customer Support. See “Obtaining technical assistance” on page 2 for Customer Support options.

**Tooltips**
A tooltip is the information balloon that pops up when you point to a screen item.

**Status bar**
When the cursor is in a field, the status bar displays tips for filling out the field or for selecting an option from a group of options.
Acronyms, initializations and glossary

This section describes the terms used in this document.

Acronyms and initializations

The Acronyms and initializations table expands shortened words, such as abbreviations, acronyms and initializations.

<table>
<thead>
<tr>
<th>Term</th>
<th>Expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td>A/P</td>
<td>accounts payable</td>
</tr>
<tr>
<td>G/L</td>
<td>general ledger</td>
</tr>
<tr>
<td>J/E</td>
<td>journal entry</td>
</tr>
<tr>
<td>P/C</td>
<td>petty cash</td>
</tr>
<tr>
<td>P/O</td>
<td>purchase order</td>
</tr>
<tr>
<td>PDF</td>
<td>Portable Document Format</td>
</tr>
</tbody>
</table>

Glossary

The glossary lists terms and their meanings, as used in this document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>accounts payable</td>
<td>Obligations to suppliers of merchandise or services purchased on an open account.</td>
</tr>
<tr>
<td>available</td>
<td>A program feature that is available for use (that is not inactive).</td>
</tr>
<tr>
<td>bank reconciliation</td>
<td>(&quot;balancing cash&quot;) The procedure of reconciling the bank balance reflected on a ledger to the bank balance reflected on a bank statement for a given period; to balance a bank statement.</td>
</tr>
<tr>
<td>batch</td>
<td>The method of identifying documents to be input to an accounting system as a group, to control data flow; in data processing, a group of items entered into a unique numerical identifier and held until processed.</td>
</tr>
<tr>
<td>bible</td>
<td>The report containing the transactions for all of the periods entered into the computer auditing system.</td>
</tr>
<tr>
<td>budget</td>
<td>A financial document that allocates a production's financial transactions to a group of accounts, each of which describes a component of film making and enables financial reporting and is classified as &quot;above the line&quot; or &quot;below the line.&quot;</td>
</tr>
<tr>
<td>budgeting</td>
<td>The act of translating a script into a budget.</td>
</tr>
<tr>
<td>chart of accounts</td>
<td>The master list of all the accounts used to track production costs, expenses, assets, liabilities and income.</td>
</tr>
<tr>
<td>check on demand</td>
<td>A single, quick-turnaround computer check produced to immediately pay an invoice.</td>
</tr>
<tr>
<td>check register</td>
<td>A report normally in check number order that identifies the checks written over a time period and that provides information such as the check date and amount; a numerical record of posted checks.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>check stock</td>
<td>An inventory of unsigned, blank checks sometimes imprinted with the production name and address, for use in the accounts payable process.</td>
</tr>
<tr>
<td>cost report</td>
<td>A detailed, weekly analysis that identifies costs to date, identifies weekly costs, and estimates the final costs to complete the production.</td>
</tr>
<tr>
<td>currency conversion</td>
<td>The conversion of foreign monetary currency in order to reflect production costs and/or transaction against a particular currency; the act of exchanging one type of currency into another type.</td>
</tr>
<tr>
<td>disposition</td>
<td>To complete an activity or change in status. For example, you disposition new entries by saving or canceling them.</td>
</tr>
<tr>
<td>edit list</td>
<td>A report that shows the items to be posted, without actually posting the items.</td>
</tr>
<tr>
<td>employee</td>
<td>A person paid for doing work under direction. See also independent contractor.</td>
</tr>
<tr>
<td>entry</td>
<td>Generic term for a record or a transaction that is saved in PSL3.</td>
</tr>
<tr>
<td>episodic budget</td>
<td>(“series budget”) The overall budget for an episodic production, such as a recurrent television show.</td>
</tr>
<tr>
<td>estimated final cost</td>
<td>(EFC) The projection of the anticipated costs to complete the production, equal to the sum of the estimate to complete and the actual costs to date for the production; usually calculated weekly during production.</td>
</tr>
<tr>
<td>execute</td>
<td>Initiate a program command to do something.</td>
</tr>
<tr>
<td>general ledger</td>
<td>The original financial statement covering the period from the beginning of the production to the current reporting period.</td>
</tr>
<tr>
<td>hand-typed</td>
<td>Usually refers to a manually produced check that was typed on a typewriter, not printed by the computer system. See also manual check.</td>
</tr>
<tr>
<td>inactive</td>
<td>A program feature that is not available for use and typically is colored gray.</td>
</tr>
<tr>
<td>independent contractor</td>
<td>An individual working for a company that is contracted to perform certain services in which the individual does not take direction in how the services are to be provided; a person performing work that does not require supervision or direction. See also employee.</td>
</tr>
<tr>
<td>instance</td>
<td>An occurrence of using a program. You may run concurrent instances of the PSL3 program (that is, you may have more than one copy of the program open).</td>
</tr>
<tr>
<td>journal entry</td>
<td>An entry made to a journal that represents a transaction.</td>
</tr>
<tr>
<td>location bank</td>
<td>The bank used by a production on location; may have correspondent banking relations established with home office bank; used primarily for payroll check cashing.</td>
</tr>
<tr>
<td>manual check</td>
<td>Checks which have been typed or handwritten, rather than generated by the computer system. See also hand-typed.</td>
</tr>
<tr>
<td>nickname</td>
<td>A short, alternative name for PSL3 programs, usually eight or fewer characters.</td>
</tr>
<tr>
<td>petty cash</td>
<td>The distribution of cash to individuals on a production for various expenses.</td>
</tr>
<tr>
<td>pick list</td>
<td>A popup screen listing the available relevant data for a field.</td>
</tr>
<tr>
<td>post</td>
<td>To permanently transfer a transaction to the general ledger.</td>
</tr>
<tr>
<td>production</td>
<td>The second phase in film making, which starts when principal photography begins and ends.</td>
</tr>
<tr>
<td>production accountant</td>
<td>The member of the production staff who determines the propriety of all financial transactions and ensures that they are documented in accordance with company policies and procedures and with applicable government requirements. The production accountant receives or generates all financial documentation for the production.</td>
</tr>
<tr>
<td>production accounting</td>
<td>The scheduling, oversight and recording of the expenditure of all funds to produce a motion picture (or a television show).</td>
</tr>
<tr>
<td>program number</td>
<td>The number on a program tab.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>program tree</td>
<td>A graphical, hierarchical method of showing program groups and the programs within them. The tree may be expanded to show lower-level branches or collapsed to show only higher-level branches.</td>
</tr>
<tr>
<td>purchase order</td>
<td>A record of expenses or of a financial commitment that serves as an approved, written contract for goods or services.</td>
</tr>
<tr>
<td>purchase order, relieving</td>
<td>Posting the accounts payable transaction that contains the lines transferred from a purchase order.</td>
</tr>
<tr>
<td>show</td>
<td>A written script filmed to be distributed as a film, movie, feature, motion picture, television pilot, television series, mini series, movie of the week, commercial, documentary, industrial, made for cable, etc.</td>
</tr>
<tr>
<td>timecard</td>
<td>A legal document used to record an employee's hours worked each week.</td>
</tr>
<tr>
<td>trial balance</td>
<td>The orderly summary of ledger accounts used specifically to extract financial statement information. See also balance sheet.</td>
</tr>
<tr>
<td>unit production manager</td>
<td>(UPM or PM) The producer's executive assigned to the production, responsible for coordinating and supervising all administrative, financial and technical details of the production, and for overseeing the activities of the entire crew.</td>
</tr>
<tr>
<td>variance</td>
<td>An estimate that deviates from the amount budgeted for that estimate, usually the difference between the actual costs of production and the budgeted costs.</td>
</tr>
<tr>
<td>vendor</td>
<td>A company or individual providing a product or service.</td>
</tr>
<tr>
<td>vendor number</td>
<td>A number identifying a specific vendor, assigned to all invoices, purchase orders, etc. of that vendor.</td>
</tr>
<tr>
<td>voided check</td>
<td>A printed check that has not been issued to the payee or posted to the computer system.</td>
</tr>
<tr>
<td>week ending</td>
<td>The date marking the end of a weekly pay period, which for local locations is five days (M–F) and for distant locations is six days (M–Sat.).</td>
</tr>
<tr>
<td>wildcard</td>
<td>A special character (in PSL3, the asterisk &quot;) that represents a character or group of characters during a search.</td>
</tr>
<tr>
<td>zero balance</td>
<td>The state of a ledger that is in balance.</td>
</tr>
</tbody>
</table>
Icons and shortcuts

PSL3 provides several methods for interacting with the program, including icons, keyboard shortcuts and mouse shortcuts. You can pick the method that best suits your work style. You may want to print the following tables to use as a quick reference.
### Pressing function keys

Pressing function keys provides shortcuts to commands, additional information, and inputting, finding, saving or changing entries. The results of pressing a function key depend on the location of the cursor:

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Cursor location</th>
<th>Result of pressing function key</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Command Field</td>
<td>Displays command screen. Commands shown depend on the accounting task and stage of data entry.</td>
<td></td>
</tr>
<tr>
<td>F2</td>
<td>Pick list Field</td>
<td>If available, displays a drop-down list of possible entries for the field.</td>
<td></td>
</tr>
<tr>
<td>F3</td>
<td>Detail Field</td>
<td>If available, displays additional information for the field.</td>
<td></td>
</tr>
<tr>
<td>F4</td>
<td>Add Field in header section or in record-entry screen</td>
<td>Creates a new entry ready to be filled in, and automatically fills in the reference number.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Field in distribution section</td>
<td>Creates a new transaction line, ready to be filled in.</td>
<td></td>
</tr>
<tr>
<td>F5</td>
<td>Zoom Field</td>
<td>Accesses or adds information from a related program while keeping the original program open.</td>
<td></td>
</tr>
<tr>
<td>F6</td>
<td>Help Program screen or field</td>
<td>Displays a C&amp;C web page with links to contact information.</td>
<td></td>
</tr>
<tr>
<td>F7</td>
<td>Find Blank field</td>
<td>Searches for and retrieves entries from your database. Pressing &lt;F7&gt; in a blank field (that is, not entering a search criterion) retrieves all the entries related to the program.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Populated field</td>
<td>Searches for and retrieves entries from your database. You can use search criteria (including the * wildcard) to narrow down the entries retrieved.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Entering a value in one or more fields and then pressing &lt;F7&gt; (that is, entering search criteria) retrieves only the entries whose value for the fields match the entered values.</td>
<td></td>
</tr>
<tr>
<td>F8</td>
<td>Back Field</td>
<td>Moves your cursor back to the previous field where you can input data.</td>
<td></td>
</tr>
<tr>
<td>F9</td>
<td>Duplicate Header field</td>
<td>Duplicates the field value from the previous entry.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distribution field</td>
<td>Duplicates the field value from the previous distribution line.</td>
<td></td>
</tr>
<tr>
<td>F10</td>
<td>Mark for deletion Header field</td>
<td>Marks the entire entry for deletion, as shown by red lines through all header fields and distribution lines.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distribution field</td>
<td>Marks an individual distribution line for deletion, as shown by a red line through the distribution line.</td>
<td></td>
</tr>
<tr>
<td>F11</td>
<td>Jump Transaction screen</td>
<td>Jumps between the header section and distribution section.</td>
<td></td>
</tr>
<tr>
<td>F12</td>
<td>Remark Field</td>
<td>Adds a remark to the displayed entry.</td>
<td></td>
</tr>
</tbody>
</table>
## Pressing named keys and key combinations

The behavior of named keys and key combinations may change, depending on the location of the cursor.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Function</th>
<th>Cursor location</th>
<th>Result of pressing keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Enter&gt;</td>
<td>Accept</td>
<td>Entry screen</td>
<td>Accept the data you entered and move the cursor forward one field.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Message screen</td>
<td>Close the message screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Command screen</td>
<td>Execute the entered command.</td>
</tr>
<tr>
<td>&lt;Tab&gt;</td>
<td>Navigate</td>
<td>Program screen</td>
<td>Move from field to field.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;Tab&gt;</td>
<td>Navigate</td>
<td>Program screen</td>
<td>Move from group box to group box.</td>
</tr>
<tr>
<td>&lt;Page Down&gt; or &lt;Page Up&gt;</td>
<td>Navigate entries</td>
<td>Pick list in an entry screen</td>
<td>Page up or page down through the list.</td>
</tr>
<tr>
<td></td>
<td>Navigate fields</td>
<td>Field in the header of a transaction entry screen that has entries</td>
<td>Display the next or previous entry for the field.</td>
</tr>
<tr>
<td></td>
<td>Navigate pages</td>
<td>Field in the distribution line of a transaction entry screen that has entries</td>
<td>Display the next or previous page of entries for the field. For example, a P/O may have more distribution lines than one screen can display. Move your cursor to a distribution field, then press &lt;Page Up&gt; or &lt;Page Down&gt; to go through the distribution lines one page at a time.</td>
</tr>
<tr>
<td>Left arrow or Right arrow</td>
<td>Navigate characters</td>
<td>Field</td>
<td>Move your cursor one character left or right.</td>
</tr>
<tr>
<td>Up arrow or Down arrow</td>
<td>Navigate entries</td>
<td>Field of a distribution line</td>
<td>Move the cursor up or down the column of distribution lines.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+U&gt;</td>
<td>Navigate fields</td>
<td>Field</td>
<td>Move the cursor back one field.</td>
</tr>
<tr>
<td>&lt;Shift&gt;+&lt;Tab&gt;</td>
<td>Navigate fields</td>
<td>Field</td>
<td>Move the cursor back one field.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+X</td>
<td>Enter data</td>
<td>Field</td>
<td>Blank out a field.</td>
</tr>
<tr>
<td>&lt;Backspace&gt;</td>
<td>Enter data</td>
<td>Field</td>
<td>Deletes the character to the left of the cursor.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;+&lt;W&gt;</td>
<td>Enter data</td>
<td>Field that has a changed entry</td>
<td>Restore the previous value of the field. Cursor must not leave the field between the entry and the restore.</td>
</tr>
</tbody>
</table>
**Right-clicking the mouse**

Clicking the right button on the mouse provides shortcuts to entering or finding data. The results of right-clicking depend on the location of your cursor:

<table>
<thead>
<tr>
<th>Cursor location</th>
<th>Right-mouse click result</th>
<th>Alternatives to right-mouse click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Field</td>
<td>If available, a pick list appears, displaying the possible entries for the field</td>
<td>Click the Pick icon or press &lt;F2&gt;</td>
</tr>
<tr>
<td>Amount field</td>
<td>A calculator displays</td>
<td>none</td>
</tr>
<tr>
<td>Date field</td>
<td>This month's calendar displays</td>
<td>none</td>
</tr>
<tr>
<td>Outside a field</td>
<td>A command screen appears, displaying a list of available commands</td>
<td>Press &lt;F1&gt;</td>
</tr>
</tbody>
</table>
Clicking toolbar icons

These tables describe the icons for program toolbars. There are three types of toolbars:

- Entry (illustrated on page 17)
- Print preview (illustrated on page 21)
- Posting, reporting and inquiry programs (illustrated on page 20)

Some icons appear on more than one toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Entry</th>
<th>Preview</th>
<th>Reporting</th>
<th>Function</th>
<th>Cursor location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>P</td>
<td></td>
<td></td>
<td>First entry</td>
<td>Field</td>
<td>Go to the first entry</td>
</tr>
<tr>
<td>E</td>
<td>P</td>
<td></td>
<td></td>
<td>Previous entry</td>
<td>Field</td>
<td>Go to the previous entry</td>
</tr>
<tr>
<td>E</td>
<td>P</td>
<td></td>
<td></td>
<td>Next entry</td>
<td>Field</td>
<td>Go to the next entry</td>
</tr>
<tr>
<td>E</td>
<td>P</td>
<td></td>
<td></td>
<td>Last entry</td>
<td>Field</td>
<td>Go to the last entry</td>
</tr>
<tr>
<td>E</td>
<td>P</td>
<td></td>
<td></td>
<td>Add entry</td>
<td>Field</td>
<td>Add a new entry</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Mark entry for deletion</td>
<td>Record-entry or header field</td>
<td>Mark the entry for deletion</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Distribution field</td>
<td>Mark the distribution line for deletion</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Find entries</td>
<td>Field</td>
<td>Find entries based on search criteria</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Update</td>
<td>Field</td>
<td>Save the changes made since the last save, and leave the current entry displayed on the screen. Example use: interim saves while entering a transaction with many distribution lines</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Accept</td>
<td>Field</td>
<td>Save the changes (including deletions) since the last save, clear the screen and leave the program open</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Cancel changes</td>
<td>Field</td>
<td>Cancel all changes and new entries since the last save, clear the screen and leave the program open</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Exit</td>
<td>Field</td>
<td>Save changes and new entries, and close the program</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
<td></td>
<td></td>
<td>Detail</td>
<td>Field</td>
<td>Display detailed information (if available) for the field</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
<td></td>
<td></td>
<td>Pick</td>
<td>Field</td>
<td>Displays a dropdown list of the available entry choices for the field</td>
</tr>
<tr>
<td>Icon</td>
<td>Entry</td>
<td>Preview</td>
<td>Reporting+</td>
<td>Function</td>
<td>Cursor location</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------</td>
<td>---------</td>
<td>------------</td>
<td>--------------</td>
<td>----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
<td>R</td>
<td></td>
<td>Zoom</td>
<td>Field</td>
<td>Opens a new program from within the current program. Used with Fetch. For example, with your cursor in the Vendor ID field of the A/P Transaction Entry program, click the Zoom icon to open the Vendor Entry program without leaving the A/P screen</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td></td>
<td></td>
<td>Fetch</td>
<td>Field</td>
<td>Populate the field from which you zoomed with data from the zoomed-to program. To continue the Zoom example, click the Fetch icon to fetch a Vendor ID back to the Vendor ID field in the A/P Transaction Entry program</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
<td>R</td>
<td></td>
<td>Help</td>
<td>Field</td>
<td>Opens the Cast &amp; Crew online help pages</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td>Clear</td>
<td>Field</td>
<td>Clear the screen</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td>Cancel entry</td>
<td>Field</td>
<td>Cancel the entry</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td></td>
<td></td>
<td>Preview</td>
<td>Field</td>
<td>Preview the report</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Save to PDF</td>
<td>Field</td>
<td>Save and preview your report as an Adobe Acrobat (PDF) file</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Zoom in</td>
<td>Field</td>
<td>Zoom in (magnify) the report preview</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Zoom out</td>
<td>Field</td>
<td>Zoom out (shrink) the report preview</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Zoom normal</td>
<td>Field</td>
<td>Zoom to preview the report at 100% actual size</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Whole page</td>
<td>Field</td>
<td>Size the preview to view the whole page</td>
</tr>
<tr>
<td>P</td>
<td></td>
<td></td>
<td></td>
<td>Page width</td>
<td>Field</td>
<td>Size the preview to the page width</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
<td></td>
<td></td>
<td>Print</td>
<td>Field</td>
<td>Open the Print dialog screen</td>
</tr>
</tbody>
</table>
Help menu ........................................ 15
Help, getting .................................... 47
Hint bar ........................................... 16
Home screen .................................... 5, 7
areas ............................................. 7
opening a program from .................... 9

I
Icons
accept ............................................ 33
add .................................................. 32
availability (blue or gray) ................. 15
cancel ............................................ 33
clear .............................................. 32
delete ............................................ 37
date ................................................ 15
eon ................................................. 24, 33
fetch .............................................. 23
find .................................................. 34
first entry ....................................... 37
last entry ........................................ 37
next entry ...................................... 37
pick ............................................... 29
previewing ..................................... 21
prior entry ...................................... 37
reference table of .............................. 57
reporting ......................................... 18
update ............................................ 33
zoom .............................................. 23
Identification area .............................. 8
Inactive fields .................................. 27
Internet Explorer ............................... 5
Invalid entries ................................. 28
Items Selected screen ........................ 44

J
J/E Transaction Entry program ........ 33, 40

K
Key combinations, reference table of .... 55
Keyboard shortcuts ......................... 14, 25, 31
command screens, for .................... 21

L
Last-entry icon ................................. 37
Logging in ....................................... 6, 9
Logging out ..................................... 9
Login Incorrect screen ...................... 6
Login screen .................................... 6
Looking up available data ................. 29

M
Manual checks .................................. 42
Menu bars
home screen ................................... 8
preview screen ................................. 21
program screens ............................. 14
Menus
edit ............................................... 15
favorites ....................................... 15
file ............................................... 15, 24
help ............................................... 15
myPSL ........................................... 8
options ......................................... 15
program ......................................... 15
support ......................................... 8
view ............................................... 15
Minus-sign button ......................... 11
Mouse scroll wheel .......................... 29
Mouse shortcuts .............................. 25, 30
Multipick ....................................... 30
myPSL menu ................................... 8

N
Navigating fields ......................... 28
Next-entry icon ............................... 37
Nicknames ..................................... 9

O
Opening (accessing) PSL3 ............... 5
Opening a program
from another program (zooming) .... 23
home screen, from ......................... 9
program tab, with ......................... 10
Optional fields ................................ 27
Options menu ................................. 15, 19, 21
reporting screens ......................... 19

P
P/C Entry program ........................... 33
P/O Entry program ........................... 33
P/O Transaction Entry program ....... 10
Password field ............................... 6
Passwords
case sensitivity .................................. 6
lost or forgotten .................................. 6
Payroll Distribution Entry program .......... 33
Pick icon ........................................ 29
Pick lists .......................................... 29
browsing .......................................... 29
closing without a selection .................... 30
multipicking ..................................... 30
right-clicking to display ....................... 19
Picking items ................................... 29
Plus-sign button ................................ 11
Post A/P Transactions program ............. 39
Post P/R Transactions program ............. 39
Posting ........................................... 38
posting by printing posting register ........ 40
reviewing transactions to be posted ...... 39
screens ........................................... 20
Pre-Check Printing Report program ........ 41
Previewing ...................................... 20
Print Checks program ......................... 42, 43
Print dialog screen ................................ 45
printed check screen ......................... 44
Printer, aligning ................................ 44
Printing
   A/P and P/C checks ......................... 41
   remote (over the internet) .......... 41
Prior-entry icon ................................ 37
Program menu (on home screen) .......... 11
   resizing ..................................... 9
Program menu bar ........................... 14
Program number .............................. 10
Program screens
   areas ........................................ 12
   edit menu ................................... 15
   favorites menu ............................. 15
   file menu .................................. 15
   grouping in program tree and menu ... 7
   help menu .................................. 15
   icons ......................................... 15
   options menu ................................ 15
   programs menu .............................. 15
   resize handle ................................ 16
   view menu .................................. 15
Program tabs .................................. 9
   customizing ................................ 9
   on top ...................................... 10
   opening a program from ............... 10
Program tree .................................. 9, 11
opening multiple programs with .......... 11
resizing ........................................ 9
Programs
   adding to favorites ......................... 22
   command screens ........................... 21
   entry screens ............................... 13
   groups ....................................... 11
   nicknames .................................. 9, 11
   open in the background .................... 10
   open in the foreground .................... 10
   opening from another program ........... 22
   opening multiple instances
      (occurrences) .............................. 11
   preview screens ............................ 20
   reporting screens ........................... 17
   transaction entry screens ............... 17
Programs menu ............................... 15, 22, 46
PSL3
   Accessing (opening) ......................... 5
opening ........................................ 5
R
Record entry .................................... 13
Reference section ......................... See Header section
Reporting ....................................... 46
   specifying search criteria .............. 46
Reporting screens ........................... 18
Reporting toolbar ........................... 18
Reports
   customizing .................................. 7
   generating output ......................... 20, 47
   output types ................................ 19
   viewing onscreen ......................... 20
Required fields .............................. 27
Resizing
   program menu ............................... 9
   program screen ............................ 16
   program tree ................................ 9
   window ..................................... 8, 14
Retrieving
   entries ...................................... 34
   fetching .................................... 23
   specific entries ........................... 35, 36
Right-clicking ................................. 10
   inside a field .............................. 18
   outside a field ............................. 19, 37
Right-clicking, reference table for ......... 56
<table>
<thead>
<tr>
<th>S</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving entries</td>
<td>33</td>
</tr>
<tr>
<td>Screens</td>
<td></td>
</tr>
<tr>
<td>resizing</td>
<td>8</td>
</tr>
<tr>
<td>select an action</td>
<td>24</td>
</tr>
<tr>
<td>warning, sample</td>
<td>28</td>
</tr>
<tr>
<td>Search criteria</td>
<td></td>
</tr>
<tr>
<td>specifying</td>
<td>35</td>
</tr>
<tr>
<td>wildcard</td>
<td>35</td>
</tr>
<tr>
<td>Selected fields</td>
<td>27</td>
</tr>
<tr>
<td>Selecting checks for print</td>
<td>44</td>
</tr>
<tr>
<td>Settings</td>
<td></td>
</tr>
<tr>
<td>customizing</td>
<td>8</td>
</tr>
<tr>
<td>enter key behavior</td>
<td>28</td>
</tr>
<tr>
<td>Settings menu</td>
<td>8</td>
</tr>
<tr>
<td>Setup-entry screens</td>
<td>13</td>
</tr>
<tr>
<td>Shortcut menus, entry</td>
<td>32, 37</td>
</tr>
<tr>
<td>Shortcuts</td>
<td></td>
</tr>
<tr>
<td>data entry and selection</td>
<td>29</td>
</tr>
<tr>
<td>keyboard</td>
<td>25</td>
</tr>
<tr>
<td>keyboard and mouse</td>
<td>53</td>
</tr>
<tr>
<td>keyboard, for opening menus</td>
<td>14</td>
</tr>
<tr>
<td>mouse</td>
<td>25</td>
</tr>
<tr>
<td>Windows, creating</td>
<td>5</td>
</tr>
<tr>
<td>Specifying search criteria</td>
<td>35, 36</td>
</tr>
<tr>
<td>Spreadsheets</td>
<td>47</td>
</tr>
<tr>
<td>Spreadsheets, generating reports as</td>
<td>40</td>
</tr>
<tr>
<td>Start-menu item, creating</td>
<td>5</td>
</tr>
<tr>
<td>Status bar</td>
<td>36, 48</td>
</tr>
<tr>
<td>Status bar</td>
<td>35</td>
</tr>
<tr>
<td>Submenus</td>
<td>14</td>
</tr>
<tr>
<td>Summary check register</td>
<td>45</td>
</tr>
<tr>
<td>Support menu</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title bar</td>
<td>8, 14</td>
</tr>
<tr>
<td>Toobars</td>
<td></td>
</tr>
</tbody>
</table>

| entry                         | 15   |
| previewing                    | 21   |
| reporting                     | 18   |
| Tooltips                      | 48   |
| Transaction entry screens     |      |
| areas                         | 17   |
| distribution section          | 17   |
| header section                | 17, 35|
| Transactions                  |      |
| balancing                     | 33   |
| correcting                    | 39, 40|
| posting                       | 39   |

<table>
<thead>
<tr>
<th>U</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update icon</td>
<td>33</td>
</tr>
<tr>
<td>User names or passwords, lost or forgotten</td>
<td>6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>V</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor Entry program</td>
<td>13, 35, 36</td>
</tr>
<tr>
<td>Vendor Listing program</td>
<td>46</td>
</tr>
<tr>
<td>View menu</td>
<td>15, 21</td>
</tr>
<tr>
<td>Voids</td>
<td>44</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>W</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warning, sample screen</td>
<td>28</td>
</tr>
<tr>
<td>web browser, web page</td>
<td>5</td>
</tr>
<tr>
<td>Wildcard, using</td>
<td>35</td>
</tr>
<tr>
<td>Windows buttons</td>
<td>8, 14</td>
</tr>
<tr>
<td>Working area</td>
<td></td>
</tr>
<tr>
<td>entry screens</td>
<td>16</td>
</tr>
<tr>
<td>reporting screens</td>
<td>18</td>
</tr>
<tr>
<td>transaction entry screens</td>
<td>17</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Z</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero checks, printing</td>
<td>43</td>
</tr>
<tr>
<td>Zooming</td>
<td>23</td>
</tr>
</tbody>
</table>